
 

โครงงานสหกิจศึกษา เรื่อง การสร้างแผนที่และระบุพิกัดต าแหน่งท่ีตั้งวัด 
กรณีศึกษาวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการสิ่งแวดล้อมใน
วัด ของกรมส่งเสริมคุณภาพสิ่งแวดล้อม 

โดย นางสาวณัฏฐา เวชการ 
ที่ปรึกษาโครงการสหกิจศึกษา นางสาวลักขณา มุ่งวัฒนา 

สถานที่ปฏิบัติงานสหกิจศึกษา ส านักส่งเสรมิการมีส่วนร่วมของประชาชน กรมส่งเสรมิ
คุณภาพสิ่งแวดล้อม 
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ความเป็นมาและความส าคญัของปัญหา 
 ปัญหาเรื่องการจัดการขยะมูลฝอย เป็นปัญหาที่ประเทศไทยประสบอยู่ในปัจจุบัน
อันเนื่องมาจากการขยายตัวอย่างรวดเร็วของชุมชนและจ านวนประชากรที่เพิ่มขึ้น ท าให้มี
ปริมาณขยะมูลฝอยเพิ่มขึ้น และตกค้างจนเกิดปัญหาขยะล้นเมือง อีกทั้งการจัดเก็บและน า
ขยะไปจัดการตามขั้นตอนไม่สามารถด าเนินการได้ทันกับจ านวนของขยะมูลฝอยที่มีปริมาณ
มาก ส่งผลให้มีขยะมูลฝอยตกค้างถูกทิ้งตามพื้นดิน แม่น้ า และเผาท าลาย เกิดปัญหามลพิษ
ต่างๆ ตามมา โดยปัญหาขยะมูลฝอยจ าเป็นต้องอาศัยความร่วมมือจากทุกภาคส่วน ทั้ง
ภาครัฐ ภาคเอกชน และประชาชน ในการร่วมกันแก้ไขปัญหา กรมส่งเสริมคุณภาพ
สิ่งแวดล้อมจึงเล็งเห็นถึงความส าคัญของวัด ซึ่งเป็นส่วนหนึ่งที่จะช่วยส่งเสริมการเรียนรู้การ
จัดการมูลฝอยตามหลัก 3R ได้แก่ ลดการใช้ การใช้ซ้ า การคัดแยกน ามาใช้ใหม่ รวมทั้งการ
อนุรักษ์และจัดการสิ่งแวดล้อมให้แก่ศาสนิกชน ได้ตระหนักและเกิดจิตส านึกในด้านการ
จัดการสิ่งแวดล้อม อีกทั้งวัดยังสามารถเป็นแหล่งเรียนรู้ด้านสิ่งแวดล้อม และขยายผลการ
จัดการสิ่งแวดล้อมที่ดีสู่ชุมชนโดยรอบได้อีกด้วย 

กรมส่งเสริมคุณภาพสิ่งแวดล้อมมีบทบาทภารกิจที่ส าคัญประการหนึ่ง คือ การ
ส่งเสริมสนับสนุนให้ประชาชนทุกภาคส่วนได้มีส่วนร่วมในการสงวน บ ารุงรักษา
ทรัพยากรธรรมชาติและสิ่งแวดล้อม จึงได้ด าเนินการส่งเสริมพัฒนาการมีส่วนร่วมด้านการ
จัดการสิ่งแวดล้อมในวัด เริ่มตั้งแต่ปี 2557 เป็นต้นมา โดยมีวัตถุประสงค์เพื่อสร้างความรู้
ความเข้าใจ สร้างความตระหนักและจิตส านึกด้านการจัดการขยะมูลฝอย รวมทั้งการอนุรักษ์
และจัดการสิ่งแวดล้อมแด่พระภิกษุสงฆ์ และร่วมเป็นเครือข่ายในการสร้างความตระหนัก
และจิตส านึกให้กับชุมชน พร้อมทั้งส่งเสริมให้วัดมีการพัฒนาการจัดการสิ่งแวดล้อมที่ดี 

กรมส่งเสริมคุณภาพสิ่งแวดล้อมได้วางแผนด าเนินงานโครงการส่งเสริมพัฒนาการ
จัดการสิ่งแวดล้อมในวัดต่อเนื่อง เพื่อขยายพื้นที่ด าเนินงานและเพิ่มจ านวนวัดที่จะเป็นแหล่ง
เรียนรู้และเป็นต้นแบบด้านการจัดการสิ่งแวดล้อมให้มากขึ้น เพื่อให้วัดมีจัดการสิ่งแวดล้อมที่
ดีขึ้น สามารถเป็นแหล่งเรียนรู้และเป็นต้นแบบด้านการจัดการสิ่งแวดล้อม และเป็นข้อมูล
เพื่อเผยแพร่ต่อไป 

จากวัดที่ได้เข้าร่วมโครงการ กรมส่งเสริมคุณภาพสิ่งแวดล้อมจึงได้จัดท าฐานข้อมูล
ของวัดที่เข้าร่วมโครงการการจัดการสิ่งแวดล้อมในวัดของแต่ละปีที่ได้สมัครเข้าร่วมโครงการ
ซึ่งมีวัดที่ผ่านเกณฑ์ในระดับดีเยี่ยม ระดับดีมาก ระดับดี และวัดที่เข้าร่วมแต่ไม่ผ่านเกณฑ์
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การประเมิน ซึ่งฐานข้อมูลเหล่านี้สามารถน าไปจัดท าแผนที่ต าแหน่งที่ตั้งและความหนาแน่น
ของวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการสิ่งแวดล้อมในวัด เพื่อให้เห็นว่ามีวัดที่เข้า
ร่วมโครงการส่งเสริมพัฒนาการจัดการสิ่งแวดล้อมในวัดแต่ละปีมีการกระจายตัวมากน้อย
เพียงใด 

วัตถุประสงค์ 
1. เพื่อระบุพิกัดต าแหน่งที่ตั้งวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ

สิ่งแวดล้อมในวัด 
2. เพื่อสร้างแผนที่ต าแหน่งที่ตั้งของวัดที่เข้าร่วมโครงการ 

พื้นที่ศึกษา 
  

 
ภาพ 1 แสดงพืน้ที่ศึกษา 

พื้นที่ที่มีวัดเข้าร่วมโครงการส่งเสริมพัฒนาการจัดการสิ่งแวดล้อมในวัด ตั้งแต่
ปีงบประมาณ 2557 – 2559 จ านวนทั้งหมด 49 จังหวัด ดังนี้ กรุงเทพมหานคร กระบี่ 
ขอนแก่น ฉะเชิงเทรา ชลบุรี ชัยนาท ชุมพร ตรัง นครนายก นครปฐม นครพนม นครราชสีมา 
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นครสวรรค์ นนทบุรี น่าน บึงกาฬ ปราจีนบุรี พระนครศรีอยุธยา พะเยา พัทลุง พิษณุโลก 
ภูเก็ต ยะลา ระนอง ราชบุรี ร้อยเอ็ด ลพบุรี ล าปาง ล าพูน ศรีสะเกษ สกลนคร สงขลา สตูล 
สมุทรสาคร สระบุรี สิงห์บุรี สุพรรณบุรี สุราษฎร์ธานี สุรินทร์ หนองคาย อุตรดิตถ์ อุทัยธานี 
อุบลราชธานี อ่างทอง เชียงราย เชียงใหม่ เพชรบูรณ์ เลย และแพร่ 

ข้อมูลที่ใช้ในการด าเนินงาน 
ข้อมูลที่ใช้ในการวิเคราะห์นั้น ส านักส่งเสริมการมีส่วนร่วมของประชาชน กรม

ส่งเสริมคุณภาพสิ่งแวดล้อม ได้ท าการเก็บรวบรวมไว้แล้ว ได้แก่ รายชื่อวัด ที่อยู่ของวัด และ
เกณฑ์การประเมิน ซึ่งเป็นข้อมูลของวัดที่เข้าร่ วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด ปี 2557 – 2559 รวมทั้งหมด 522 วัด  

ขั้นตอนและวิธีการด าเนนิงาน 
 1. เปิดโปรแกรม Google Earth เพื่อใช้ค้นหาต าแหน่งวัดที่เข้าร่วมโครงการ 
จากนั้นพิมพ์ชื่อวัดที่ต้องการค้นหา เช่น วัดด่านใน ต าบลด่านใน จังหวัดนครราชสีมา แล้วกด
ค้นหา เมื่อกดค้นหา จะพบต าแหน่งวัดที่ต้องการ เมื่อพบต าแหน่งวัดที่ต้องการ จากนั้นใช้

เครื่องมือเพิ่มหมุด  คลิกที่ต าแหน่งวัด แล้วจะปรากฏค่าพิกัดต าแหน่งวัดดังรูป 

 
ภาพ 2 การค้นหาต าแหน่งวดัและหาค่าพิกัด 

2. จากนั้นน าค่าพิกัดต าแหน่งที่ค้นหาได้ใส่ลงใน Microsoft Excel เพื่อเป็น

ฐานข้อมูลในการท าแผนที่ต่อไป 

 

ค่าพิกัดต าแหน่ง 

ค้นหาต าแหน่งวัด
ด่านใน 
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ภาพ 3 บันทึกค่าพิกัดต าแหนง่ลงใน Microsoft Excel 

 3. น าข้อมูล Shape File ขอบเขตประเทศไทยและไฟล์ Excel ที่บันทึกค่าพิกัด
ต าแหน่งวัดที่เข้าร่วมโครงการฯ ปี 2557-2559 เข้าโปรแกรม ArcGIS ดังรูป 

 
ภาพ 4 แสดงขอ้มูลที่ใช้วเิคราะห์ 

4. ท าการแบ่งภูมิภาคเป็น 6 ภูมิภาค โดยการ Clip คลิกเมนู Arc Toolbox เลือก 
Analysis Tools > Extract > Clip เช่น เมื่อต้องการ Clip เพื่อแบ่งภาคใต้ ให้เลือกจังหวัดที่
อยู่ภาคใต้ แล้วท าการ Clip จากนั้นจะได้ขอบเขตที่เป็นภาคใต้ ดังรูป 

  
ภาพ 5 การแบง่ภูมิภาค 

ขอบเขตประเทศไทย 

จุดต าแหน่งวัด 

ค่าพิกัดต าแหน่ง 

Arc Toolbox 

ขอบเขตภาคใต้ 

เลือกจังหวัดที่อยู่ภาคใต ้
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5. เมื่อท าการ Clip ครบแล้ว จะแบ่งภูมิภาคออกเป็น 6 ภูมภิาค ดังรูป 

 
ภาพ 6 แสดงขอบเขตทั้ง 6 ภมูิภาค 

 6. ท าการแบ่งวัดที่ได้คะแนนระดับต่างๆ คือ ระดับดีเยี่ยม ระดับดีมาก และระดับดี 
โดยการ Clip คลิกเมนู Arc Toolbox เลือก Analysis Tools > Extract > Clip เช่น เมื่อ
ต้องการ Clip เพื่อเลือกวัดที่ได้ระดับดีเยี่ยม ให้เลือกวัดที่ได้ระดับดีเยี่ยม แล้วท าการ Clip 
จากนั้นจะได้ต าแหน่งวัดที่ได้ระดับดีเยี่ยมดังรูป 

 
ภาพ 7 การแบง่วัดที่ได้เกณฑ์การประเมินระดับต่างๆ 

 

 

 

 

 

ภาคเหนอื 

ภาคตะวันออกเฉียงเหนอื 

ภาคตะวันออก 
ภาคใต้ 

ภาคกลาง 

ภาคตะวันตก 

เลือกวัดทีไ่ด้ระดับดีเยีย่ม 
จุดสีเหลืองคือวัดที่ได้ระดับดีเยี่ยม 

Arc Toolbox 
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 7. เมื่อท าการ Clip ครบแล้ว จะได้ต าแหน่งวัดที่ได้คะแนนระดับต่างๆ ดังรูป 

 
ภาพ 8 แสดงต าแหน่งวัดที่ได้ระดับดีเยี่ยม ระดับดีมาก และระดับดี 

 8. การเลือกเฉพาะพื้นที่ที่มีวัดเข้าร่วมโครงการฯ เพื่อดูความหนาแน่นของวัดที่เข้า
ร่วมโครงการฯในแต่ละปี ตัวอย่างเช่น ปี 2557 โดยคลิกขวาที่ Shape File ประเทศไทย > 
เลือก Open Attribute Table > จากนั้นเลือกจังหวัดที่มีวัดเข้าร่วมโครงการฯ ในปี 2557 
แล้วใช้เครื่องมือ Clip เหมือนกับข้อ 5. และ 7. จากนั้นจะได้พื้นที่ที่มีวัดเข้าร่วมโครงการฯ 
เมื่อได้พื้นที่แล้วน าไฟล์พิกัดต าแหน่งวัดขึ้นมาแสดง ดังรูป 

  
ภาพ 9 แสดงความหนาแน่นของวัดที่เข้าร่วมโครงการฯ ในแตล่ะพื้นที่ 

9. เมื่อได้วิเคราะห์ข้อมูลครบถามวัตถุประสงค์แล้ว จากนั้นท าการออกแบบแผนที่
ให้ครบถ้วนสมบูรณ์ โดยเริ่มจากการตั้งชื่อแผนที่ ให้คลิกที่เมนู Insert แล้วเลือก Title จะได้
ดังรูป 

จุดสามเหลีย่มสีชมพคูือวัดที่ได้ระดับด ี

จุดวงกลมสีฟา้คอื
วัดที่ระดับดีมาก 

จุดสี่เหลี่ยมสีเหลืองคือวดัที่ได้ระดีบดีเยีย่ม 

พื้นที่และต าแหน่งวัด 

ที่เข้าร่วมโครงการฯ 
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ภาพ 10 การใสช่ื่อใหก้ับแผนที่ 

 10. ใส่ค าอธิบายสัญลักษณ์เนื้อหาที่ปรากฏอยู่บนแผนที่ คลิกที่เมนู Insert > 
Legend จะได้ดังรูป 

 
ภาพ 11 การใสค่ าอธิบายสัญลักษณ ์

 11. สร้างพิกัดกริดบนแผนที่ ซึ่งเป็นการก าหนดต าแหน่งและใช้อ้างอิงในการบอก
ต าแหน่ง โดยคลิกขวาที่รูปแผนที่ เลือก Properties เลือก Grid > New Grid จะได้ดังรูป 

 
ภาพ 12 การสร้างพิกัดกริด 

 12. สร้างเครื่องหมายทิศให้กับแผนที่ โดยคลิกที่เมนู Insert แล้วเลือก North 
Arrow และสร้างแถบมาตราส่วน คลิกเมนู Insert > Scale bar จากนั้นเลือกรูปแบบแถบ
มาตราส่วนที่ต้องการ แล้วคลิกปุ่ม OK จะได้ดังรูป 

พิกัดกริด 

ชื่อแผนที ่

ค าอธิบายสัญลักษณ ์
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ภาพ 13 การสร้างเครื่องหมายทิศและสร้างแถบมาตราส่วน 

 13. การเพิ่มตราสัญลักษณ์หรือรูปภาพอื่นๆ คลิกเมนู Insert > Picture จากนั้น
เลือกรูปแบบที่ต้องการ แล้วคลิกปุ่ม OK เมื่อตกแต่งแผนที่จนครบถ้วนสมบูรณ์แล้ว จากนั้น
ท าการ Export Map คลิกเมนู File >  Export Map เพื่อที่จะได้เป็นภาพแผนที่ออกมา  

  
ภาพ 14 การเพิ่มตราสัญลักษณ์หรือรูปภาพอื่นๆ และการ Export Map 

ผลการด าเนนิงาน 
จากข้อมูลที่ได้ศึกษาและรวบรวม สามารถน าข้อมูลที่วิเคราะห์ได้ แสดงออกมาใน

รูปแบบของแผนที่แสดงต าแหน่งที่ตั้งวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด และแผนที่แสดงความหนาแน่นของวัดที่ เข้าร่วมโครงการส่งเสริม
พัฒนาการจัดการสิ่งแวดล้อมในวัด ปี 2557-2559 ดังนี้ 

1. แผนที่แสดงต าแหน่งที่ตั้งวัดที่ เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด ปี 2557 มี 41 วัด มีวัดที่ได้เกณฑ์การประเมินระดับดีเยี่ยม 14 วัด ระดับดี
มาก 11 วัด และระดับดี 16 วัด 

ทิศ 

แถบมาตราส่วน 

ตราสญัลักษณ ์
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ภาพ 15 แผนทีแ่สดงต าแหน่งที่ตั้งวัดที่เข้าร่วมโครงการ ส่งเสริมพัฒนาการจัดการ

สิ่งแวดล้อมในวดั ปี 2557 
2. แผนที่แสดงต าแหน่งที่ตั้งวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ

สิ่งแวดล้อมในวัด ปี 2558 มี 175 วัด มีวัดที่ได้เกณฑ์การประเมินระดับดีเยี่ยม 16 วัด ระดับ
ดีมาก 17 วัด ระดับดี 23 วัด และวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการสิ่งแวดล้อม
ในวัด แต่ไม่ผ่านเกณฑ์การประเมิน 119 วัด 

 

 
ภาพ 16 แผนทีแ่สดงต าแหน่งที่ตั้งวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจดัการสิง่แวดล้อม

ในวัด ปี 2558 

3. แผนที่แสดงต าแหน่งที่ตั้งวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด ปี 2559 มี 306 วัด มีวัดที่ได้เกณฑ์การประเมินระดับดีเยี่ยม 38 วัด ระดับ
ดีมาก 64 วัด ระดับดี 64 วัด และวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการสิ่งแวดล้อม
ในวัด แต่ไม่ผ่านเกณฑ์การประเมิน 139 วัด 
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ภาพ 17 แผนทีแ่สดงต าแหน่งที่ตั้งวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจดัการสิง่แวดล้อม

ในวัด ปี 2559 

4. แผนที่แสดงความหนาแน่นของวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด ปี 2557 ในปี 2557 นี้ มีวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด มากเป็นอันดับแรกคือจังหวัดเชียงราย จ านวน 9 วัด อันดับสองคือจังหวัด
ล าพูนและชุมพร มีจ านวน 4 วัด และอันดับสามคือจังหวัดอุตรดิตถ์ เลย และนครพนม มี
จ านวน 3 วัด 

 
ภาพ 18 แผนทีแ่สดงความหนาแน่นของวัดที่เข้าร่วมโครงการสง่เสริมพัฒนาการจัดการ

สิ่งแวดล้อมในวดั ปี 2557 
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5. แผนที่แสดงความหนาแน่นของวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด ปี 2558 ในปี 2558 นี้ มีวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด มากเป็นอันดับแรกคือจังหวัดอ่างทอง จ านวน 71 วัด อันดับสองคือจังหวัด
บึงกาฬ มีจ านวน 25 วัด และอันดับสามจังหวัดเชียงใหม่ มีจ านวน 17 วัด 

 

 
ภาพ 21 แผนทีแ่สดงความหนาแน่นของวัดที่เข้าร่วมโครงการสง่เสริมพัฒนาการจัดการ

สิ่งแวดล้อมในวดั ปี 2558 

6. แผนที่แสดงความหนาแน่นของวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด ปี 2559 ในปี 2559 นี้ มีวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด มากเป็นอันดับแรกคือจังหวัดราชบุรี จ านวน 28 วัด อันดับสองคือจังหวัด
พิษณุโลก มีจ านวน 27 วัด และอันดับสามจังหวัดอุบลราชธานี มีจ านวน 20 วัด 
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ภาพ 22 แผนทีแ่สดงความหนาแน่นของวัดที่เข้าร่วมโครงการสง่เสริมพัฒนาการจัดการ

สิ่งแวดล้อมในวดั ปี 2559 
สรุปผลการด าเนนิงาน 

จากข้อมูลที่ได้ด าเนินการวิเคราะห์ ตั้งแต่มีการเริ่มโครงการส่งเสริมพัฒนาการ
จัดการสิ่งแวดล้อมในวัด เมื่อปี 2557 มีวัดทั่วประเทศสนใจเข้าร่วมโครงการเป็นอย่างมาก
และมีจ านวนวัดที่เข้าร่วมโครงการมากขึ้นทุกปี จากข้อมูลจึงเห็นได้ว่าบางวัดได้เข้าร่วม
โครงการแล้วแต่ยังไม่ผ่านเกณฑ์การประเมิน วัดนั้นจึงได้มาสมัครเข้าร่วมโครงการอีกครั้งจน
ผ่านเกณฑ์การประเมิน ท าให้เห็นว่าวัดเริ่มมีความตระหนักในเรื่องการจัดการสิ่งแวดล้อมใน
วัดมากขึ้น 

เมื่อวัดมีความตระหนักเรื่องการจัดการสิ่งแวดล้อมในวัดมากขึ้น นับเป็นจุดเริ่มต้นที่
ดีในการดูแลสุขภาพอนามัยทั้งทางกายและทางใจของพระภิกษุสงฆ์ สามเณร และประชาชน
ทั่วไป โดยเน้นการจัดการสิ่งแวดล้อมในวัด บนพื้นฐานด้านการจัดการ ควบคุมดูแลและ
ปรับปรุงสภาวะต่างๆ ควบคู่กับการให้ความส าคัญด้านการมีส่วนร่วมของทุกภาคส่วน 
โดยเฉพาะท้องถิ่นและชุมชน และสามารถพัฒนาให้เป็นตัวอย่างที่ดีด้านการจัดการ
สิ่งแวดล้อมให้กับวัด หน่วยงานหรือผู้สนใจอย่างเป็นรูปธรรม สามารถน าเสนอผลงานและ
เป็นแบบอย่างด้านการจัดการสิ่งแวดล้อมน าไปสู่การสานต่อการด าเนินงานด้านการส่งเสริม
พัฒนาการจัดการสิ่งแวดล้อมในวัดให้เป็นที่รู้จักในวงกว้างต่อไป 
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ข้อเสนอแนะ 
 สามารถน าข้อมูลผลการด าเนินงานไปพัฒนาต่อยอดการวิเคราะห์และแสดงผลผ่าน
เครือข่ายอินเตอร์เน็ต เพื่อการใช้งานอย่างสะดวกยิ่งขึ้น 
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ชื่อสถานที่ 
 กรมส่งเสริมคุณภาพสิ่งแวดล้อม 

ที่ตั้ง  
 49 พระราม 6 ซอย 30 พญาไท กรุงเทพมหานคร 10400 เบอร์โทรศัพท์ : 0-2278-
8400-19 หรือ E-mail : info@deqp.mail.go.th 
ฝ่าย/แผนก/กอง 

 กลุ่มวิชาการและประสานการมีส่วนร่วม ส านักส่งเสริมการมีส่วนร่วมของประชาชน 

สถานประกอบการประเภท 
หน่วยงานราชการ  

ลักษณะการประกอบการ 
 บูรณาการทุกภาคส่วนในการบริหารจัดการทรัพยากรธรรมชาติและสิ่งแวดล้อม
อย่างมีธรรมาภิบาลด้วยองค์ความรู้และกระบวนการมีส่วนร่วม 
พันธกิจ 
1. สร้างจิตส านึกและส่งเสริมการมีส่วนร่วมในการบริหารจัดการทรัพยากรธรรมชาติและ
สิ่งแวดล้อม 
2. เพิ่มศักยภาพ และขีดความสามารถของเครือข่ายภาคีที่เกี่ยวข้องเพื่อการบริหารจัดการ
สิ่งแวดล้อม 
3. พัฒนา ประยุกต์ และให้บริการสารสนเทศด้านสิ่งแวดล้อม 
4. วิจัย พัฒนา และถ่ายทอดเทคโนโลยีเพื่อการส่งเสริมคุณภาพสิ่งแวดล้อม 

งานที่ได้รับมอบหมาย 
 1. สนับสนุนงานวิชาการ กลุ่มวิชาการและประสานการมีส่วนร่วม 

- ช่วยสนับสนุนงานวิชาการ ตามที่ได้รับมอบหมาย 
        - ประสานงานเครือข่ายร่วมด าเนินงาน เพื่อให้เป็นไปตามวัตถุประสงค์ 

ข้อมูลสถานทีป่ฏิบัติงานสหกิจศึกษา 
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        - ร่วมการประชุมวิชาการ/ปฏิบัติการ และลงพื้นที่สนับสนุนงานโครงการ
ที่ได้รับมอบหมาย 

       - งานอื่นๆ ที่ได้รับมอบหมาย 
2.พัฒนาฐานข้อมูลเพื่อระบุพิกัดต าแหน่งที่ตั้งวัดที่ เข้าร่วมโครงการส่งเสริม

พัฒนาการจัดการสิ่งแวดล้อมในวัด ของกรมส่งเสริมคุณภาพสิ่งแวดล้อม บนแผนที่ 
    - ศึกษาข้อมูลและทบทวนวรรณกรรม 
   - ขั้นตอนการระบุพิกัดต าแหน่งที่ตั้งวัด 
   - จัดท าฐานข้อมูลเชิงพื้นที่เพื่อจัดท าแผนที่ 
  - ท าแผนที่ต าแหน่งที่ตั้งวัดที่เข้าร่วมโครงการส่งเสริมพัฒนาการจัดการ
สิ่งแวดล้อมในวัด ของกรมส่งเสริมคุณภาพสิ่งแวดล้อม 
   - สรุปผล 

งานที่ได้เรียนรู้ใหม่จากสถานประกอบการ 
 - การท าเอกสารทางราชการ 
 - การท ารายงานสรุปการประชุม 
 - ได้เรียนรู้งานการจัดงานการประชุม 
 - มีส่วนร่วมประสานงานเครือข่ายการด าเนินงานภายในส านักส่งเสริมการมีส่วน
ร่วมของประชาชน 
 - มีร่วมการประชุมวิชาการ/ปฏิบัติการ โครงการที่ได้รับมอบหมาย 

ความคาดหวังจากการปฏิบัติสหกิจศึกษา 
 - ทักษะในการท างานร่วมกับผู้อื่น 
 - ทักษะในการแก้ไขปัญหา 
 - ทักษะทางวิชาชีพ เช่น การท าหนังสือราชการ ระเบียบวินัยในองค์กร 
 - ได้รับความรู้เพิ่มเติมด้าน GIS เพื่อน าไปประยุกต์ใช้ 

ผลประโยชน์ที่ได้จากการปฏิบัติสหกิจศึกษา 
 - ได้รับความรู้เกี่ยวกับระบบงานราชการ 

- เรียนรู้ประสบการณ์ท างาน การปรับตัวในที่ท างาน 
- รู้วิธีการบริหารจัดการเครือข่ายการท างานจากกลุ่มเป้าหมายการท างานที่ต่างกัน 
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ผลตอบแทนที่ได้จากการปฏิบัติงาน 
 ไม่มีผลตอบแทนจากการปฏิบัติงาน 

ปัญหา การจัดการ และข้อเสนอแนะ 
 ข้อเสนอแนะ 

ในการส่งตัวนิสิตเพื่อมาปฏิบัติสหกิจศึกษา ควรแจ้งข้อมูลเบื้องต้นเกี่ยวกับ
สาขาวิชาที่เรียน และแจ้งวัตถุประสงค์การปฏิบัติสหกิจศึกษาเพื่อให้ไปตามเป้าหมายของ
สาขาวิชาภูมิศาสตร์ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


